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Lesson 2
Update, Upgrade, or
Reinstall macOS

Every new Mac comes with the Mac operating system. To get

the latest features and security updates, you will eventually GOALS

need the latest macOS. If you have a qualifying Mac, you can

upgrade at no cost. »wescribe the differ-

ences between a macOS

WARNING » Some exercises in this lesson involve sig- update, upgrade, and
nificant changes to your Mac setup. Some of the st€ps reinstallation
are difficult or impossible to reverse. If you pepfoyn
the exercises in this lesson, do so on a spare Mac o an » Describe the macOS
external disk that doesn’t contain criticasdata. installer

» Verify system
Reference 2.1 information

macOS Installation Methods

Identifying the parts of a Mac operating system name will > Update macOS

help you understand.theldifference between an upgrade and s an
an update. A Mag operating’system has a version name and a > Ubgrade mac

version number, such asgmacOS Big Sur 11. .
& » Reinstall macOS

When Apple releases an update to macOS Big Sur:
» Troubleshoot
The version name stays the same (Big Sur). an upgrade or

The first part of the version number stays the same (11). reinstallation

Apple adds additional numbers after 11. For example,
the first update for macOS 11.0 was 11.0.1. And the next
update released was 11.1.

When Apple releases a major version upgrade of the Mac
operating system, there is a new version name (for example,
Big Sur instead of Catalina).

15



16 Update, Upgrade, or Reinstall macOS

Although all previous versions of macOS have a version number that starts with “10.” (for
example, macOS 10.0 through macOS 10.15), macOS Big Sur uses “11” to start its version
numbers.

This list summarizes the differences between updating, upgrading, reinstalling, and
installing a Mac operating system:

Update: Installs an incremental update of the Mac operating system but doesn’t
upgrade it to the next major version (if one exists).

Upgrade: Installs a next major standalone version of the Mac operating system.

Reinstall: Installs the same major version of macOS on a volume thatalready has
macOS. This overwrites existing system files but leaves apps; useriome folders, and
other files in place.

Install: Installs macOS on a volume that doesn’t have. macOS=-for instance, a volume
you erased.

NOTE » The terms disk, volume, and storagéfavesimilar meanings. Where possible,
this guide uses terms that appear in apps,on scréen. Read Lesson 11, “Manage File
Systems and Storage,” for more infgrmatiOong

Lesson 6, “Update macOS,” describe§ intmeore detail updating macOS and keeping macOS
automatically updated.

Upgrading, reinstalling, or installing macOS Big Sur requires internet access.

Erase Your StartupsDisk

If you want to get a fresh start with macOS and you don’t need the existing content on
your Mac, erase the startup disk before you install macOS. The macOS installer (an app
named Install macOS Big Sur) doesn’t erase disks, but you can use Disk Utility to erase a
disk before you run the macOS installer:

If you want to erase the system disk your Mac is currently running from, you
can erase it if you start up from macOS Recovery, as covered in Lesson 5, “Use
macOS Recovery”

If the destination is another disk, such as an external storage device, erase and install
from your Mac, as covered in Lesson 11.
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Reference 2.2
Prepare to Upgrade or Reinstall macOS

Follow these steps to prepare to start a macOS upgrade:

1 Verify installation requirements.
2 Back up important content.
3 Plug notebook computers into power.

4 Download macOS Big Sur.

Verify Installation Requirements
Verify that both your Mac and its operating system meet the requirements for an upgrade
to macOS Big Sur. This includes verifying the hardwate and,thesSoftware.

To upgrade from OS X Mountain Lion 10.8, firsttupgrade to OS X El Capitan 10.11, then
upgrade to macOS Big Sur.

Upgrading to macOS Big Sur has the following,requirements:

OS X Mavericks 10.9 or later
4 GB of memory

35.5 GB of available storage to upgrade from macOS Sierra 10.12, or 44.5 GB of
available storagesto tpgrade from an earlier release

Compatible intefnet'service provider (for some features)

Apple ID (for some features)
macOS Big Sur supports the following Mac models:

MacBook introduced in 2015 or later
MacBook Air introduced in 2013 or later
MacBook Pro introduced in late 2013 or later
Mac mini introduced in 2014 or later

iMac introduced in 2014 or later

iMac Pro

Mac Pro introduced in 2013 or later

17



18 Update, Upgrade, or Reinstall macOS

See Apple Support article HT211238, “macOS Big Sur is compatible with these computers”
at https://support.apple.com/support.apple.com/HT211238 for more information about
requirements for specific features. Some features of macOS Big Sur require specific Mac
and i0S or iPadOS device models, such as the following features:

Continuity Camera—Use your iPhone, iPad, or iPod touch to scan documents or
take a picture of something nearby and it appears instantly on your Mac. Continuity
Camera is supported in many apps, including Mail, Messages, the Finder, and more.
See Apple Support article HT209037, “Use Continuity Camera on your Mac,” for
more information.

Handoff—With Handoff, you can start work on one device, thenwitch to another
nearby device and pick up where you left off. Use Handoff with any Mac, iPhone,
iPad, iPod touch, or Apple Watch that meets the Continuity system requirements.
See Apple Support article HT204689, “System requirements for Continuity on Mac,
iPhone, iPad, iPod touch, and Apple Watch,” for more information.

Instant Hotspot—With Instant Hotspot, thePersonal Hotspot on your iPhone

or iPad (Wi-Fi + Cellular) can provide interneta€cess to a Mac, iPhone, iPad, or
iPod touch without requiring you,to efiter the password on those devices. Use
Instant Hotspot with any Mac, iPhong, iPad, or iPod touch that meets the Continuity
system requirements. See Apple'Support article HT209459, “Use Instant Hotspot

to connect to your PersonalfHetspet without entering a password,” for more
information.

Universal Clipboard—With Universal Clipboard, you can copy content such as text,
images, photgs§, and videos on one Apple device, then paste the content on another
Apple devicedse Universal Clipboard with any Mac, iPhone, iPad, or iPod touch
that meets the Ceofttinuity system requirements. See Apple Support article HT209460,
“Use Universal Clipboard to copy and paste between your Apple devices,” for more
information.

See Apple Support article SP833, “macOS Big Sur - Technical Specifications” at support.
apple.com/kb/SP833 for more information.

Verify System Information

You need to know your Mac computer’s specifications when you install new software,
upgrade installed software, perform maintenance, or troubleshoot a problem. In this
section you learn how to find essential system information with About This Mac and
System Information.


https://support.apple.com/support.apple.com/HT211238
http://support.apple.com/kb/SP833
http://support.apple.com/kb/SP833
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You can open the Apple menu and choose About This Mac to gather most of the informa-
tion necessary to confirm that your Mac supports macOS Big Sur. About This Mac displays
information such as the macOS software version, Mac model name, chip (for a Mac with
Apple silicon) or processor type and speed (for an Intel-based Mac), total system memory,
startup disk, graphics card information (for an Intel-based Mac), and Mac serial number.

NOTE » A Mac may not display a serial number if the necessary post-repair proce-
dures were not successfully completed after a logic board replacement.

The Mac in the following figure has 16 GB of RAM and meets the memory requirements
to run macOS Big Sur.

A few items are vital to identifying your macOS version and Mac model:

»  The macOS version number represents the system software yersion currently installed.

»  The macOS build number is more specific than the maeOS+ersion number alone.
In the About this Mac window, click the mac@®S SeftWare version number to find
the build number. Apple creates specific build %ersions of each macOS version as
they refine it. A newly released model 6f Mac may require a specific build of macOS;
the specific build may differ from the standard installation versions. For example,
the first day the new MacBook Pro“(l3sinch, 2020, Two Thunderbolt 3 ports) was
shipped, one model came with mac@S 10.15.4 (19E2265), another model with dif-
ferent options came withgmacOS»1045.4 (19E2269), but other Mac computers that
were up to date were zunning macOS 10.15.4 (19E287). For more information, see
Apple Supportarticle FIT201686, “Use the Mac operating system that came with your
Mac, or a compatible néwer version.”

4 ~
[ ] Displays Storage Support Service

macQS Catalina

MacBook Pro (15-inch, 2018)

Processor 2.6 GHz 6-Core Intel Core i7
Memory 16 GB 2400 MHz DDR4

Startup Disk Macintosh HD

Graphics Intel UHD Graphics 630 1536 MB
Serial Number

System Report... Software Update...

19



20 Update, Upgrade, or Reinstall macOS

» The Mac computer model name is derived from the product marketing name for the
Mag, followed by a relative release date. For example, the previous screenshot was
taken on a “MacBook Pro (15-inch, 2018)”

» The Mac serial number is located on the Mac case. The serial number is a unique
number used to identify a Mac for maintenance and service.

Click the Storage button to review how much disk space is available.

@ =)
[ ] Overview Displays Support  Service

* — Macintosh HD
216.46 GB available of 1 TB

Documents

178
Flash Storage

\ J

The Mac in this figure meets the available-storage r ments to upgrade to macOS Big Sur.

The Support and Service buttons link t@ specific areas of the Apple Support web-

site. The contents of the links are generate amically to show the most up-to-date sup-

o3

ac. For example, the Specifications link opens

port information about macOS and

a webpage with the full specificati your Mac.
( N
@ Dve%)l lays Storage Service
’ € macOSs Help

macOS Resources @ User Manual

& macOS Support

@ Specifications

! © Hardware Support

Mac Resources
© Regulatory Certification

© Important Information...




Reference 2.2 Prepare to Upgrade or Reinstall macOS

The information in the About This Mac window is a subset of what you can find with

System Information. From the Overview window in the About This Mac window;, click

the System Report button to open System Information. Or you can press and hold

the Option key and then choose Apple menu > System Information. Or you can use
Spotlight; click the Spotlight icon (which looks like a magnifying glass) in the menu bar
in the upper-right corner of your screen, enter System Information in the search field,

then press Return.

If you have a version of the Mac operating system that shipped with the name OS X

(instead of macOS), it includes System Profiler instead of System Information.

® @ MacBook Pro A'J 0
ATA Hardware Overview:
Apple Pay Model Name: MacBook Pro
Audio Model Identifier: MacBookProl5,1
Bluetooth Processor Name: 6-Care Intel Core i7
i ba A e 1
Card Reader Total Number of Cores: [
Contraller L2 Cache (per Core): 256 KB
Diagnostics L3 Cache: aMB
Disc Burning Hyper-Threading Technology: Enabled
Ethernet Cards Memaory: " 16 68
> Boot ROM Version: @
Fibre Channel Serial Number (system):
FireWire Hardware UUID: 4 0‘
Graphics/Displays Activation Lock Status: Dizabled
Memory
MVMExpress
PCI
Parallel SCSI
Fower
Printers
SAS
SATA/SATA Express
SPI f
Storage
Thunderbolt I
Use
¥ Network
Firewall
Locations
Volumes
\JE > Hardware Y,
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When you need to create a file to document the current state of a Mac, use
System Information. Go to the menu bar, then choose File > Save. This creates
a System Information-specific file (with the .spx filename extension) that you
can open from other Mac computers.

Verify App Compatibility
When you upgrade to macOS Big Sur, your third-party apps might need updates to
function properly. You can use System Information to view installed apps. For older



22 Update, Upgrade, or Reinstall macOS

Mac computers with System Profiler instead of System Information, verify that View >
Full Profile is selected to reveal the Applications section in the Contents list. Selecting
Applications from the Contents list prompts macOS to scan common locations on the
local volume for available apps.

You don’t have to worry about the apps that came with your Mac, such as Safari, Mail, and
Photos. They are automatically upgraded when you install macOS Big Sur. You might have
to visit third-party vendor websites to find out if your third-party apps require updates.

Back Up Important Files and Folders

It’s always crucial to keep backups of your important files and folderssHaying a current
backup is even more critical when you make significant change§ to'a.Mac, such as install-
ing a major version upgrade to the Mac operating system. Iffanewsifistallation or upgrade
is done improperly, it could result in complete data loss,

You can't uninstall or revert an update or upgrade Ifit turns out that an app you need is
not compatible with macOS Big Sur, the only wa¥ito install an earlier version of macOS is
to erase and restore from backup.

You can use Time Machine to create a backidp before you start your installation. Using
Time Machine is covered in Lesson 7,%Manage Time Machine”

Document Network Settings

The macOS installer help§"nsure that you don’t lose previous settings when you upgrade
to macOS Big SurgBut soie settings are so vital to your Mac that you should document
them in case something goes wrong.

In particular, if you have any special network configuration, such as a static IPv4 address,
or a specific Domain Name Service (DNS) server to use, document your network settings
before you upgrade. Open System Preferences and click the Network icon to observe your
current network settings. Avoid missing settings by navigating through the network inter-
face and all the configurations.

You can quickly document your settings by using the Screenshot utility. Just press Shift-
Command-5. Press the Space bar to change the pointer to a camera icon; then you can
move your pointer to highlight different windows. Click to capture the highlighted win-
dow, or use the Screenshot menu to change what’s captured, to capture video, to change
where you save the file, to set a timer, or to modify several other options. After you finish
your screenshot or video capture, its preview appears in the corner of the screen. Drag
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the preview into a document, click the preview and mark it up, or just leave it and the
Screenshot utility will automatically save it to your desktop with a filename of “Screen
Shot” followed by the date and time of the capture. Be sure to print or copy your screen-
shots to another storage device before you install macOS Big Sur.

P o=
~

Wi-Fi

wi-Fi  TcPiP JEIERl WINS  8021X  Proxies  Hardware

DNS Servers: Search Domains:
1.1.1.1 | pretendco.con’]

Capture Selected Portion

NOTE » When you use Screenshot re a window, you can exclude the win-

G

shot to the Clipboard, pres old

dow’s shadow. Just press and he tion key when you click. To copy a screen-
the Control key while you take the screenshot.
You can then paste the sgfeetaishot somewhere else. Or you can use Universal Clipboard
to paste it on anoth@ device. See Apple Support article HT201361, “Take a

0

screenshot o r r more information.

Plug Mac Notebo into Power
Plug your Mac into an AC power outlet during the upgrade to ensure that the upgrade
completes successfully.

Download macOS Big Sur

If you're using OS X El Capitan v10.11.5 or later, macOS Big Sur downloads in the back-
ground, making it easier to upgrade your Mac. When the download finishes, you receive
a notification indicating that macOS Big Sur is ready to be installed. Click Install in the
notification to get started.

macOS Big Sur is free and available from Software Update preferences or the App Store.
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If you're using macOS Mojave 10.14 or later:

1 Open System Preferences.
2  Open Software Update preferences.

3 Click Upgrade Now.
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app/macos-big-sur/id15268781

pp Store: “macOS Big Sur” at apps.apple.com/
lick the Get button.

(ene

Q macOS Big Sur

Utilities ﬂ
Applo

et as

£

w Discover

é Arcade

A Create

o work

o Play

A Develop

@ Categories

) Updates @B

Nee=@dO*a B8 -~ O@O8 " =8

machS Big Sur elevates the world's most advanced deskiop operating system to a new level of power and beauty.
Expanence Mac 1o the fullest with a refined new design. Enjoy the biggest Safar update ever. Discover new features
for Maps and Messages. And gel even mare lransparency arcund your privacy.

Design mone

@

L Ratings & Reviews



http://apps.apple.com/app/macos-big-sur/id1526878132
http://apps.apple.com/app/macos-big-sur/id1526878132

Reference 2.3 Upgrade or Install macOS

NOTE » In the previous figure, App Store displays the number 2 next to Updates.
This is because there are two apps that have updates available, but you can install
these updates only after you upgrade to macOS Big Sur.

Reference 2.3

Upgrade or Install macOS

The App Store downloads Install macOS Big Sur and places it in your /Applications folder.
After the download is complete, Install macOS Big Sur automatically opens.

Follow these steps to upgrade to macOS Big Sur:

1 Begin installation.

2 Allow installation to complete.

Begin Installation

Be sure you are connected to the internet when you upgrade or install macOS. The
macOS installer downloads any available fizhware updates specific to your Mac. These
firmware updates don’t apply to extepmal devices, such as those connected with USB,
Thunderbolt, or target disk mode,

You can use these supported fools and methods to upgrade or install macOS:

macOS installer.

Bootable installef; then the macOS installer. Read Exercise 5.2, “Create a macOS
Install Disk.”

Start up from macOS Recovery and install macOS. Read Lesson 5 to learn more.

Use the startosinstall command, inside the Install macOS Big Sur app, which is outside
the scope of this guide. See Apple Support article HT208020, “How to install macOS
at your organization,” for more information.

Use the “Install OS update” command using your organization’s mobile device man-
agement (MDM) solution, which is outside the scope of this guide.

Use the Install macOS Big Sur app to install macOS on your startup disk. For details on
using macOS Recovery to upgrade, reinstall, or install macOS Big Sur, read Lesson 5.
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Select the Installation Destination

During macOS Big Sur installation, the only choice you make is the installation destina-
tion—you select the disk where macOS is installed. This can be an internal or external
volume, as long as it’s properly formatted. The default selection is the current startup
disk. The Show All Disks button appears if it is possible for you to select an alternate
destination.

~

Install macOS Big Sur

ma

To set up the latio S Big Sur, click Continue.

C D" o

If necessary, provide administrator credentials to install a helper tool.

You may not be able to select certain disks or partitions when using the installer (read
Reference 11.1, “File Systems,” for more information about partitions). This happens when
the installer determines that your Mac can’t start from those disks or partitions. Possible
reasons include the following:

»  The disk is in target disk mode. Read Reference 11.5, “Troubleshoot File Systems,” for
more information about target disk mode.

» The disk doesn’t have the proper partition scheme for your Mac. Mac computers use
the GPT (GUID Partition Table) scheme. Use Disk Utility to repartition the disk.



Reference 2.4 Troubleshoot Installation Issues

The partition isn’t formatted properly. macOS Big Sur requires a partition format-
ted as Apple File System (APFS). Use Disk Utility to erase an improperly formatted
partition.

The macOS installer doesn’t support installing to a volume that’s part of a RAID
(Redundant Array of Independent Disks) set.

The macOS installer doesn’'t support installing to a disk containing Time Machine
backups.

The storage volume isn't from Apple and isn’t compatible with macOS Big Sur.

You might need to click Restart to continue the macOS Big Sur installatien.

Allow Installation to Complete
During normal installation, the Mac restarts at least once and possibly multiple times. If a
power loss or storage device disconnection occurs, restapt the installation.

The macOS installer is designed to never delete fionsystem data from the selected destina-
tion. The macOS installer ensures that user data andicompatible third-party apps remain
functional after an installation. The macOS isfstaller upgrades your current Mac operating
system or installs macOS to a volume (exeepta volume connected by target disk mode)
that’s attached to your Mac.

If the Install macOS Big Sur app,detectsiincompatible files and settings during an upgrade,
it moves those files to a foldemnamed Relocated Items in the /Users/Shared folder of your
startup volume. See “If you'see a Relocated Items folder on your Mac after upgrading
macOS” in the macOSWserGuide support.apple.com/guide/mac-help/mchl8ae423a3 for
more information.

Apps that are not compatible with macOS Big Sur are left in place, but macOS displays
a prohibitory symbol as part of the app icon. If you try to open incompatible software,
macOS displays information about why the app cannot be opened.

Reference 2.4

Troubleshoot Installation Issues

The macOS installer can back out of an installation and restore the previous system if an
installation goes wrong. Verify that your Mac meets the requirements for macOS Big Sur

and complete the installation preparation steps as outlined in this lesson to avoid installa-
tion problems.
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macOS Installer Troubleshooting
Beyond failing to prepare for an installation, the most common installation failures come
from internet access and destination volume problems. For example:

» The installer has filtered or no access to the internet.

» The installer might be unable to verify the selected volume or partition. This indicates
serious storage device problems. Refer to the troubleshooting steps in Lesson 11 to
resolve this issue.

For more information, see Apple Support article HT204904, “How to reinstall macOS.

Installer Log @

You can use the log file to troubleshoot macOS. The Instal tains progress and
error entries for nearly every installation step, includin hown in the standard
interface. %

& Install macOS BigSur File Edit
Minimize

| Zoom

Install macO3 Big Sur

Installer ' ng

During the initial installation phases, choose Installer Log from the Window menu to
access the log. The Installer log helps you pinpoint problems or verify installation.

After the preliminary installation phases, the installer enters the main installation phase
and locks the Mac screen. You can only watch the installation progress bar. If the installa-
tion fails, the system restarts to the previous version of macOS.



Exercise 2.1 Prepare a Mac for Upgrade

After the Mac resumes normal operation, you can access the full Installer log with

Console after you log in.

When you use macOS, error dialogs appear only if an issue is something you can resolve
or that requires immediate attention. Otherwise, running processes and apps leave
detailed information in log reports throughout macOS.

Console collects log messages and reports that are generated from your Mac and con-
nected devices. Use Console to collect diagnostic information so that you can trouble-
shoot problems. You can open Console in at least two ways:

»  Search with Spotlight.
» Navigate to /Applications/Utilities/ and double-click Cons

After Console opens, select Log Reports in the left column @@ elect install.log.

s N )

LR Console @ ]
Now load Share

£ Johnny's MacBoo...

File Nama

system.log , 932 PM System

£\ Crash Reports
install.log System

® Spin Reports displaypolicyd.0:2:0.loa 1212120, 9:02 PM System
Log Reparts faek anf= error lng 1212170 ALA2 PM Swstam
a Chil 2020-12-92 21:32:14-08 localhost rograsﬂ??l Progress UL App Starting
& Di tic Report: 2000-12-02 21:32:16-88 John sek-A ed[204]: sof ted: Starting with build 11.8.1 (28850)
3 Diagnostic RePOMS 3400 12 62 2102:22-08 Johfivs T softwareupdatod(206): Initislizing Sof twarsUpdateMacCantraller

ik Mac Analytics Data -1 Wsof twareupdated(288]: Initialized SoftwareUpdateMacController

cBock=Air sof pdated(286]: SUOSUAL : Setting alarm event stream

[ system.log 2028-12-82 21:82:22-
handler

2020-12-02 1.4 s=MacBook-Air softwareupdated[284]: SUOSUAuthenticationManager: Disabling lecal

g nnys-HacBook-Adr softwar 2061 : Errer reading /var/folders/zz/
BRRBOLE/C/com. apple. O5Update . SUOSUServiceDaemon, :tue Erros Domain=N3CoccabrrorDomein Code=248
e SUpdate. SUDSUServiceDaemon. state” couldn't be opened because there is no such file."
Path=/var/folders/zz/zyxvpnvabestavn_ C. -apple.0SUpdate. SUDSUServiceDaemon. state,
r=8x7f {Error Domai rorfomapin Code=2 *No such file or directory*h} J

Even during a successful installation, there are warnings and errors. Many of the reported
issues are benign, and you should concern yourself with them only if you are trying to iso-
late a problem that prevents a successful upgrade to macOS Big Sur.

Exercise 2.1
Prepare a Mac for Upgrade

NoTE » This exercise is for independent study only. You don’t perform this exercise
in a classroom environment. Perform this exercise only if you are upgrading your

Mac from an earlier version of macOS.
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P> Prerequisites
»  Your Mac must be running OS X Mavericks 10.9 or later.
»  Your Mac must have 4 GB of memory.

» If your Mac is running macOS Sierra 10.12 or later, it must have 35.5 GB of
available storage. If your Mac is running OS X El Capitan 10.11 or earlier, it
must have 44.5 GB of available storage.

HT211238, “macOS Big Sur is compatible with these comp

» For more information on compatible Mac computers, see Apple Support article

In this exercise, you verify that your Mac supports macQS Big Sut You also check for old
software and record important settings.

NoTE » This exercise can't be used to prepardaafindependent-study Mac for the rest
of the course. Independent learners m@St®omplete Exercise 2.3, “Erase a Mac and
Install macOS Big Sur,” to continue¥ Bxexfise 3.1, “Configure a Mac for Exercises.”

Check Hardware and App Compatibility

1 Log in to your existing administrator account.

2 In the Findeg'navigate to the /Applications/Utilities folder.
You can also use,the Finder keyboard shortcut Shift-Command-U.

3 Open System Information.



	Cover
	Title Page
	Copyright Page
	Contents at a Glance
	Table of Contents
	About This Guide
	Installation and Configuration
	Lesson 2 Update, Upgrade, or Reinstall macOS
	Reference 2.1 macOS Installation Methods
	Reference 2.2 Prepare to Upgrade or Reinstall macOS
	Reference 2.3 Upgrade or Install macOS
	Reference 2.4 Troubleshoot Installation Issues
	Exercise 2.1 Prepare a Mac for Upgrade
	Exercise 2.2 Upgrade to macOS Big Sur
	Exercise 2.3 Erase a Mac and Install macOS Big Sur
	Exercise 2.4 Verify That macOS Is Installed Correctly


	Index
	A
	B
	C
	D
	E
	F
	G
	H
	I
	J
	K
	L
	M
	N
	O
	P
	Q
	R
	S
	T
	U
	V
	W
	X
	Z




